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Introduction

forecast

= to
calculate a
future
result

Welcome to Easy Way Computer Basics Windows 8.1.

This book has been written using Office 2013 with Windows 8.1. (The Windows 7 operating
system can be used. However screen shots will differ slightly from those shown in this book.)

Retrievable Exercise Files

Some exercise files have been created for you to prevent time in keying in many exercises. You
can then open these files and use the features of Word to manipulate and format text.

A list of these files is shown on page ix and instructions for downloading these files from our
web site are included on page x.

What you will learn

In this course you will learn how to -
e Logon and log off a computer
e Understand Windows 8.1 desktop and structure
e Create files, save, open, copy, name, rename, move, and delete
e Search for and locate files
e Create folders and name them appropriately
e Understand about common threats to data stored in a personal computer
e Gain knowledge of data protection'measures used on a personal computer

e Learn of measures to secure the system from unauthorised access

How you will learn

This book is divided into sections. Each section page lists the learning outcomes for that
section. You will work through each section and do all exercises.

Revision theory is included at the end of each section followed by a Student Activity. Our books
include accumulation and consolidation of learning which carries across each section.

Word meaning boxes

Sometimes you will see a box at the left side of the page of a line that has dotted underlining.
This box will contain information to help you understand the meaning of the underlined word
(or how that word is formed). An example is shown below.

sales figures. Worksheets can be saved, opened and printed as required.



Glossary

Generally when a word(s) is first used that is a technical term or a word that you may not know
that relates to an exercise, or a particular Word 2013 feature, a description is given. You will
also see that such words are in bold.

These terms are listed on each section page, an example is shown below. Explanations are also
included in the Glossary at the end of the book.

% In this section you will come across the following words highlighted in bold. This
indicates that the word is included in the Glossary at the end of the book together
with a description of that word.

AutoCorrect Format Replace
Clipboard Microsoft Office Help Selecting Text
Correction Signs Move Text Synonyms and Thesaurus

Icons used in this book

This book contains icons to help guide you in your learning.

The following list shows the icon and its meaning.

3@ Learning Outcomes

Learning Outcomes are displayed on the section page and describe what you will learn in that
section.

EXERCISE 1

These are the exercises that you are required to do. Often there will be an introduction
sentence to tell you what you will be doing in that exercise.

% These are notes for your information.

25 Revision

This appears at the end of each section and contains theory revision questions relating to
features learnt in that section.

Student Activity

A student activity is provided at the end of the book and covers consolidation of topics learnt
for additional practice.



Save Options

When a document is saved you will be requested to select the location, ie Computer then click
on the Browse button and select the folder required. You can eliminate this procedure by
selecting the location and saving directly to the Save dialog box and therefore bypass Backstage
view.

For the purposes of this book we have used the Documents folder within This PC as the default
folder. This folder is shown below which is the shortcut for the actual path name of
C:\Users\User Name\Documents. This means that files you open and save will be on your hard
drive.

Use the following instructions to specify the Documents folder as the default file location:

. FILE . i
1 Click on the - tab then click on .

Save

2 Clickon at the left.

3 Ensure that the Documents folder is displayed as the Default local file location as shown
below.

Don't show the Backstage when opening or saving files
[] Show additional places for saving, even if sign-in may be required.

[] Saveto Computer by default

Default local file location: |—C:\U sersiCheryl\Docurments', Browse...

4  Also ensure that Don’t show the Backstage when opening or saving files option displays a
tick.

5 Remove the tick from the next option Show additional places for saving, even if sign-in
may be required.

6 Click on OK.

If you wish to open and save files to OneDrive (ie the cloud) use instructions on the next page.

If you have Windows 8, or have updated to Windows 8.1 from Windows 8, SkyDrive may be
displayed instead of OneDrive but is essentially the same.

Vi



OneDrive

OneDrive is a cloud storage application from Microsoft. It is one of the major online file storage
options competing with Dropbox and Google Drive.

Because files are stored “in the cloud” (in addition to your hard drive) it means that you can
access those files from anywhere in the world because you will always have access to the
OneDrive application and your files. You do however need an Internet connection for the files
to be updated from your hard drive to OneDrive.

Saving to OneDrive

OneDrive is automatically set up when Microsoft Office 2013 (ie Office 365) is installed on your
computer. A OneDrive folder will be displayed on the Navigation Pane in Windows Explorer as

below.
4 f@a OneDrive
[ Documents
Favorites
Pictures
./ Public

Shared favorites

Files can be saved manually by clicking on the Save button H on the Quick Access Toolbar,

specifying a name for your file then clicking on the % Onelrive jcon (you may wish to double
click on Documents and save to that folder).

OneDrive as the Default File Location

Use the following instructions if you wish to specify OneDrive as your default file location.

. FILE . i
1 Click on the - tab then click on .

Save

2 Click on at the left.

3 Ensure that the C:\Users\User Name\OneDrive\Documents folder is displayed as the
Default local file location as shown on the next page. (You may need to retype the
location)

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a
tick.

vii



5 Remove the tick from the next option Show additional places for saving, even if sign-in
may be required.

Don't show the Backstage when opening or saving files
[[] Show additional places for saving, even if sign-in may be required.

[[] Saveto Computer by default

Default local file location: ChUsers\Cheryl\Onelrive\Docurments Browse...
6 Click on OK.
OneDrive Website

You can log in to the OneDrive website using your web browser with your login name and
password.

The website is www.OneDrive.live.com.

You can upload photos and use files and share files.

Creat
New files can be created through OneDrive by clicking on and selecting

the program you wish to use, eg Word (web applications in OneDrive are slightly
cut-down versions of Office 2013 programs).

@ Create v @ Upload

Folder

Word document

Excel workbook
PowerPoint presentation
OneNote notebook
Excel survey

Plain text document

Sharing Files

From within Word 2013 you can save files to OneDrive (usually to the Documents folder) and

. . FILE .
then share those files. You can then click on the - tab, on and invite people to
share files in OneDrive.

Alternatively, you can right click on a file in the OneDrive website (see above) and select
Sharing.

Use Google in your web browser to search for additional information on OneDrive.

viii



Exercise Files used in this book

(Instructions are included on the following page for downloading retrievable files
from our web site at www.cherylprice.co.nz)

Names of folders

Budget

Faxes

Names of files

AbeecoW Fashion Xpress
Advert for Medieval Fayre Fit For Life Gym

ASB Bank Hat

Beads, Seeds and Shells Jury Service

Brie & Fresh Tomato Recipe Motor Homes

Car P-Cruises

Cashflow Quotation

Creative Caps Requirement Scheme
Davidsons TROUT MEUNIERE




Downloading Exercise Files

The exercise files listed on the previous page can be downloaded from the Cheryl Price web
site using the instructions below.

For the purposes of this book we have specified Exercise files to be downloaded to the
Documents folder within This PC which is the shortcut for the actual pathname of
C:\Users\User Name\Documents. This is where files will be opened from and saved to.

1 In the address bar of Internet Explorer, type: www.cherylprice.co.nz

2 Press Enter on the keyboard to display the Cheryl Price website.

3 Click in the Resources tab as shown at the right.

Under the heading of Easy Way Books - Computing

Click on Easy Way — Computer Basics

6 Under the Exercise Files heading click on the underlined blue hyperlink, ie
Computer Basics - Windows 8.1 Free Download

The File Download dialog box will display.

7 a Clickon * Saveas

then
b Change file name to Easy Way — Windows 8.1 Basics Book Exercise Files.
¢ Click on the Documents folder shown below.

4 M| Thiz PC

%} The Documents folder under This PC is the shortcut for
C:\Users\User Name\Documents

Save

d Clickon

8 a Click on Open folder

b Right click on the zipped exercise file and select Extract All. Click on Extract.
A folder will be created containing the exercise files.

¢ Delete the Compressed (zipped) Folder.




Section

1

Getting Started in Windows 8.1
Using Windows 8.1 Applications
Working with Multiple Programs
Viewing System Information

PN .
™/ Learning Outcomes

At the end of this section you should be able to -

0 Log

on and start Windows 8.1

O Use Windows 8.1 applications such as Paint, WordPad, Notepad to
create, save and print

0O 0O 0O 0 O

U Log

Connect and save to a USB Drive and disconnect

Work with multiple programs

View system information

Use the Help feature to find information and search for a topic

Use File Explorer to:

Browse through a folder structure to find files
View files and folders

Display file and folder properties

Use file names that clearly identify a file
Create a logical structure for folders and files

off/shut down the computer.

@ In this section you will come across the following words highlighted in bold. This
indicates that the word is included in the Glossary at the end of the book together
with a description of that word.

Charms Bar Minimize Button Snap

Close Button Navigation Pane Start Button
Default Printer Peek Start Window
Desktop Quick Access Toolbar Taskbar

File Explorer Recycle Bin Title Bar

File Extensions Ribbon USB Drive
Maximize Button Shake USB Port

© Cherylprice.co.nz Limited
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Log on Procedures

log on You may have to “log on” when you first turn your computer on. This protects your work as

S0 | only you have access to your computer data or your particular part of the network.

Depending on the way your computer or network is setup you may have to enter a user name
and password, or you may simply have to click on a named icon and enter the relevant
password.

EXERCISE 1

When you start Windows 8.1 your name and email address are usually displayed as well as a
Password box. (If this is not displayed, the desktop will appear as shown on the next page.)

1  Ensure your computer is turned on.

2  Type your password into this box which appears as asterisks.

An example is shown below.

Cheryl Price

cheryl@cherylprice.co.nz

= =~

3  Click on the right arrow E to log on to your computer or network.

On a network or a group computer log on options may be displayed similar to that shown
below.

2 SECTION 1 © Cherylprice.co.nz Limited



Getting Started in Windows 8.1

Your desktop may look different to the one below; it may have a different background picture
and it may contain different icons.

Recycle

Bin
/ Desktop
Your computer may have
additional items on the
desktop, and a different
background picture.
Start —_
button \
Internet Explorer button \ File Explorer button Taskbar
(pinned but not open) (shaded to show the window is open)

Parts of the Windows 8.1 desktop are described below.

Desktop

The desktop is the first screen that appears when Windows is loaded. You can change the look
of the desktop by altering the background picture (called “wallpaper”), adding/removing
icons, etc.

Start Button

The Start button is used to access all the programs loaded on your computer. It also provides
access to various Windows settings.

Recycle Bin

When files are deleted from the hard drive they are sent to the Recycle Bin, where they can be
restored if necessary or permanently deleted.

Taskbar

Some programs are permanently “pinned” to the Taskbar meaning that their button always
displays even if the program is not in use. The taskbar also displays all programs currently open
as buttons. An open program has a shaded box around it. A pinned program that is not
currently opened does not have a shaded box.

File Explorer

A file management program used to organise files and folders, eg the files stored permanently
on your hard drive. The File Explorer button is pinned to the taskbar by default.

© Cherylprice.co.nz Limited SECTION1 3



Starting a Program

The Start button is located in the bottom left corner of the screen and is used to access
programs, change settings, open documents, and find items in Windows.

EXERCISE 2

1  Click on the Start button . The Start window will display. Your Start window will
contain different programs, depending on what is installed on your computer.

2 Point to a blank part of the screen, and a horizontal scroll bar displays at the bottom,
as shown below. Use this to scroll across the screen to view more programs that are
installed on your computer.

Desktop
button

/ \

Apps button :
Horizontal scroll bar

3 Point to a blank part of the screen again.

4 At the bottom left of the screen click on the Apps button .

The screen now shows all of the apps loaded on your computer grouped alphabetically by
name within categories.

5  Scroll to the right until you get to a group of apps under the heading _

6 Clickon to open the Paint app.

% When you close an app, you are automatically returned to the desktop.

To return to the desktop from the Start window, you can click on the large
Desktop button under the word Start as shown at the right (refer to the
capture of the screen above for the location of the Desktop button).

4 SEcTION 1 © Cherylprice.co.nz Limited



Parts of a Window

You will notice that many windows contain common elements. These elements are labelled
and described below.

Quick Access Toolbar Tabs Title Bar Minimize\ ,Maximize
o cgos T \ %

Ribbon —|

N

Quick Access Toolbar

Status Bar \ Window Border

A toolbar containing buttons for commonly performed actions. By default the Quick Access
Toolbar buttons include Save, Undo and Redo, but other buttons can be added.

Title Bar

Displays the name of the currently open file, and the program name. If the window is not
maximised, the Title Bar can be used to drag it to another part of the screen.

Tabs

Clicking on a tab displays the relevant Ribbon with buttons used for various program functions.

Minimize Button

Clicking on the Minimize button reduces the window to a button on the taskbar.

Maximize Button

Increases the size of the window to display full screen. When a window is maximised, the

Maximize button displays as the Restore Down button . Clicking on the Restore Down
button will reduce the size of the window.

Close Button

The Close button closes the window and the program that is open.

© Cherylprice.co.nz Limited SECTION1 5
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Ribbon

A strip at the top of the screen made up of buttons used to perform various functions which
relate to the selected tab.

Status Bar

Displays information about the current file.

Window Border

Used to resize the window. When the mouse pointer is moved to the edge of the window it
will change to a double-headed arrow — click and drag the window border to resize the window
if it is not full screen (maximised).

Vertical Scroll Bar

A bar with arrows on either end used to scroll the program screen up.and down.

Working with the Minimize Button

EXERCISE 3
1  Click on the Minimize button = in the top right corner of the window.

The Paint window will appear as a button at the bottom of the screen on the taskbar.
2 Torestore Paint, click on the Paint icon on the taskbar.

The Paint window will be displayed as it was before you minimised it.

Working with the Maximize Button

For this exercise it is assumed that your window starts at the default size (ie not maximised).

If your Paint window is maximised (fills the whole screen) click on the Restore Down button &
before continuing with the following exercise.

EXERCISE 4

1  Inthe Paint window, click on the Maximize button O at the top right of the window.

The Paint window will expand to display fully on screen. Notice that the window extends
right out to the edges of your screen. This allows you to see everything within the window.

2  Look at the Maximize button now and you will notice that it has changed to the Restore
Down button O,

3 Click on the Restore Down button & to change the window back to its former size.

6 SECTION1 © Cherylprice.co.nz Limited



Moving a Window

EXERCISE 5

» To move the entire window, click on the Title Bar at the top of the screen (where Untitled
— Paint is displayed). Hold down the left mouse button and drag the Paint window around
the screen.

Resizing a Window

EXERCISE 6

1  Position the mouse pointer at the right edge of the window, as shown below. The mouse
pointer will change to a double-headed arrow.

(The mouse pointer may be white and thicker depending on the background of your
desktop.)

Position mouse/

pointer here

2  Click and drag the mouse pointer to the left to decrease the width of the window. Then
click and drag to the right to increase the width. Note that the same technique can be
used to increase or decrease the height of the window.

3  To resize the window both vertically and horizontally, position the mouse pointer in the
lower right corner of the window. Click and drag the mouse pointer diagonally away from
the window to increase the size.

L

+ Click and drag

'\‘ ____— inthis direction

4  Resize the Paint window to approximately its original size.

© Cherylprice.co.nz Limited SECTION1 7
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Snap

The Snap feature allows you to expand and maximise windows using one mouse move.

Maximising using Snap

EXERCISE 7

1  To maximise the Paint window, click and drag the Title bar to the very top of the screen
then release the mouse button.

2 Torestore it again, double click at the very top of the window.

Resizing Windows using Snap

Snap allows you to quickly expand windows either vertically or horizontally.

EXERCISE 8
1  Position the mouse pointer on the bottom window border.

2 Click and drag so that the bottom of the Paint window touches the taskbar. When you
release the mouse button, the window will be maximised vertically.

3 Toreturn to the original window size, double click on the Title Bar.

You can also “snap” a window to the left or right side of the screen by clicking on the Title Bar
and dragging the window to the far left or right. This will make the window automatically resize
to take up half the screen. This is useful for comparing windows side by side.

The Ribbon

The Ribbon is the strip at the top of the window providing access to all the tools required for
working within the program.

The Ribbon has a series of tabs along the top; click on the tab to display the tools required. The
Ribbon in Paint is very simple and only has three tabs; File, Home, and View.

With Microsoft Office programs, eg Word, Excel, Access the Ribbon has more tabs. The Ribbon
tabs for Microsoft Word are shown below.

FILE HOME INSERT DESIGN PAGE LAYOUT REFEREMNCES MAILINGS REVIEWY VIEW

EXERCISE 9

1 In Paint, click on the View tab to display the View Ribbon which displays various options
for viewing your Paint picture.

2 Click on the Home tab to return to the Home Ribbon. (The Home Ribbon always displays
Cut, Copy and Paste options and other options that are used frequently.)

8 SECTION1 © Cherylprice.co.nz Limited



Close Button

The Close button at the top right corner of the window is used to close the window and
exit the program.

@ If more than one document is open, eg two documents in Word, it will close the first document
and display the second document. When you click on the Close button again, the second
document and the Word program will close.

EXERCISE 10

>  Close the Paint program.

Notepad
Notepad is a program supplied with Windows 8.1 which allows you to create very simple text
documents.

EXERCISE 11

1  Click on the Start button then on the Apps button .

2 Scroll to the _ group, and click on which should be just

above the Paint button.

Menus

Some windows contain a menu bar at the top of the screen instead of a Ribbon. Clicking on an
item on the menu bar will display a drop-down menu. These menus provide access to features
found within the application.

As you can see Notepad has five pull down menus.

File. Edit Format View Help

=

EXERCISE 12
1 Click on File on the Menu bar.

A pull down menu will be displayed as shown below (notice shortcut keys appear at the
right of some options).

File
MNew Ctrl+M
Open... Ctrl+0
Save Ctrl+5
Save As...
Page Setup...
Print... Ctrl+P
Exit

2 Click on File on the Menu bar again to hide the pull down menu.

3 Choose File then select Page Setup. The Page Setup dialog box will display as shown on
the next page.

© Cherylprice.co.nz Limited SECTION1 9



Dialog Boxes

Various dialog box options are labelled below.

Page Setup

Paper Preview
Drop-Down Sizet A v
List Box

Source: Automatically Select W

Orientation Margins (milimeters)

(®) Portrait Left: 20 Right: |20
Option — T :
Buttons \-::::- Landscape Top: 25 Bottom: |25

Header: o

Footer: Page &p

Command
. . . Buttons
Dialog box options are described below.
Drop-Down List Box Clickon ¥ !to drop-down a list of options.
Option Buttons A dot in an Option button indicates the feature is turned on. Click

in another Option button to change the option. Only one Option
button can be chosen.

Text Boxes Double click.in a text box to select existing text (or measurement)
then type the new text required.

Sample Displays how text will appear with the chosen options.

Command Buttons Clicking on OK (or pressing Enter) within a dialog box, accepts all
the options chosen within that dialog box.

Clicking on Cancel (or pressing Esc), means that none of the changes
selected within the dialog box will take effect.

EXERCISE 13

1 Clickon | @& 5 close the dialog box.

2 Close Notepad.

10 SECTION1 © Cherylprice.co.nz Limited



Creating and Saving a Document

For this exercise you will create a document in WordPad. The document will be saved into the
Documents folder.

EXERCISE 14
1 From Windows Accessories open WordPad.

2 Type the following text into the blank document that was automatically opened when you
started the WordPad program. Press Enter twice when you want to create a blank line.

Managing a Mortgage

The budget is usually the first and most important consideration when you’re about to build,
buy or renovate a home, and for most people, that means a mortgage.

Fortunately, the days of quivering at the door to the bank manager’s office are over.
Banking these days is a competitive business, and there are plenty of good deals available.
Banks will court you with mobile mortgage managers who come to your home, 24 hour
service on approving your loan, interest ‘holidays’, prizes, and competitive fees and
charges.

3 Click on the Save button I on the Quick Access Toolbar at the top left
of the screen.

Because the document has not been saved before, the Save As dialog box will display.

4  The Navigation Pane is shown at the left of the window. If not already selected, click on
Documents under the heading This PC as shown below.

5 Doubleclickon '~ EasyWay - Windows 8.1 Basics Bock Exercise Files \which will display the folder
where your documents will be saved to (and opened from).

6 Inthe File name: box type: Mortgage as shown below.

7 Click on the Save button. (The file is saved in Rich Text Format and the file name is now
displayed at the top of the WordPad window.)
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Printing

Printing and Viewing a Print Job

EXERCISE 15

Ctrl P

1 Click onthe “ tab at the left of the Ribbon which will display the File menu.

2 Clickon . The Print dialog box is shown below.

o= Print
General

Select Printer

=0 Microsoft XPS Document Writer = OKI DATA CORP B430

=0 OKI B430(PCL) =0 5end To OneMote 2013

OKI B430(PCL) (Copy 1) on Cheryl-chris 220 5nagit 9
<

Status: Offline [ Print to file
Location:
Comment:

Page Range

@Al Number of copies: |1 __
Selection Cument Page

() Pages: 165535 V| Callate

Ertter either a single page number or a single llz’

page range. For example,

If your computer is connected to more than one printer, ensure the correct printer is

selected from the Select Printer list.

3 Clickon F

Viewing and Cancelling Printing

Once a document is sent to the printer a printer icon will appear on the Notification Area of

the taskbar ="\, Double click on this icon to view the progress of a print job. If the print job is

small you may find the printer icon appears for a second then disappears.

An alternative method is to right click on the Start button
on View devices and printers as shown below.

and select Control Panel. Click

A list of your installed printers will be displayed along with other devices. What you see will

probably differ from those shown below.
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